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Important Notice 
TaiRox does not warrant or represent that your use of this software product will be uninterrupted or error-free or that the 
software product can be run with any versions of Sage 300 other than 2012 to 2025, or that the information in this 
document is completely accurate. TaiRox warrants that any media by which you have received this software is free from 
defects. TaiRox will replace any such defective media. TaiRox expressly disclaims all other warranties, representations, 
conditions and guarantees of any kind including, but not limited to, warranties for merchantability or fitness for a 
particular use. 
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Fast DBTools Features 
Fast DBTools is a SQL Server-specific program that performs Sage 300 DBLoad, DBDump and DBCopy 
operations, copying data between a Sage 300 dataset and a SQL server database. It provides a Sage-
centric view of SQL Server databases, and supports operations that are not available using Sage tools. 

Note:  See Appendix D - Using Fast DBTools with Azure SQL Databases if you use Azure cloud services. 

Key features and benefits: 

• Fast DBLoad: A database load takes a fraction of the time taken by the standard Sage 300 utility 
– typically, it is 3x to 4x faster. 

• Fast DBDump: Any number of Sage 300 databases can be dumped in a single, unattended 
operation. Dumps are performed using multiple threads, speeding up overall operation. 

• Fast DBCopy: Database copy operations take about 60% of the time taken by the standard Sage 
utility. Further, databases can be copied directly from one SQL Server instance to another, 
eliminating tedious context switching operations. 

• Safe: Includes a "Require Exclusive Access" checkbox on the Dump & Copy forms.  

o When checked, a dump will not proceed unless the program gets exclusive database access.  

o When unchecked, Fast DBTools will try to get exclusive access, but will proceed if it can’t. 

Warns you if a database being dumped has stored procedures, views, triggers, extra tables or 

extra columns that will not be saved in a dataset. 

Records a database’s collation information in the dataset. The program will warn you if you try to 

load a dataset into a database that has a different collation sequence. 

• Visibility: Fast DBDump dumps data in a readable CSV format as well as in Sage REC format.  

All Sage 300 databases are displayed in a sortable, Sage 300-centric grid with Collation, 

Recovery Model and Log Space Available columns. Icons on the display separate Sage 300 and 
non-Sage 300 databases (e.g., CRM or Portal databases). The icons also indicate whether or not 
a Sage 300 database is connected and usable (i.e., that a Database Setup entry is present). 

• One-Stop Utility:  

Shrink DB and Shrink Log buttons quickly recover unused space in databases and database 

logs without using SQL Server Management Studio. 

Re-Index lets you rebuild corrupt and fragmented file indexes to improve database performance. 

New Database and Delete Database functions let you create new Sage 300 databases and 
delete existing ones without using SQL Server Management Studio. When creating a database 
using an existing database as a model, a Database Setup entry will be created with the same 
credentials. When deleting, the Database Setup entry will also be deleted. 

When creating a new database using an existing database as a model, you can enter the 
database description which will be used in the Database Setup entry. 

A convenient feature lets you match the Common Services company name to the description in 
the database setup tables – saving time when repeatedly loading a test copy of a database. 

• Provides Unique Capabilities: A deactivation operation cleans up tables created by old, unused 
modules. Two-character prefixes being used in a database are shown for selection. 

The Dataset Explorer opens and displays REC (or CSV) files, allowing you to scan tables and 
records in a dumped database without loading the entire database into SQL Server. You can 
associate DCT files with Fast DBTools in Windows to open and display dataset files when you 
double-click the DCT file in Windows Explorer. 

View and Update Company Database Profiles lets you view Sage 300 Database Setup 
information and update the data source / server name, SQL login ID, and password settings for 
company databases to match new system database settings. This makes it easier to transfer a 
set of company databases to a new server. 
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Starting and Connecting to the Server 

Fast DBTools is launched from the Windows Start List or from a shortcut on the desktop – like other 

Windows programs.  

When launched, Fast DBTools asks for a connection to a SQL Server instance. Connections can also be 

made using the File > Connect to SQL Server menu choice. 

 

To start Fast DBTools and log in: 

1. Click the Start List entry or shortcut to start Fast DBTools.   

If Fast DBTools does not appear in the Windows Start List or you do 

not have the shortcut on your Windows desktop, contact your 
supervisor or IT department.  

2. Enter the SQL Server and Login information on the form that 
appears. 

If you have used Fast DBTools before, the program will display the last server name as the 
default entry. If you connect to several servers, click the dropdown button beside the server name 
to view prior entries. The program remembers up to 10 server names. 

 

o Enter the name of the SQL Server that you are connecting to, or choose it from the 

dropdown. Select the “<Browse for more>” choice to browse for servers. 

If the SQL server also has an instance name, enter the name as “Server\Instance”. If you are 

running Fast DBTools on the physical SQL Server, you can enter “Localhost” as the server 
name if there is no instance name.  

− Use the Delete key to remove remembered servers from the list. 

o Enter the SQL Server Login ID and password. 

− Click the “Remember Password” checkbox to save the password for this login.  
− To forget a password, uncheck the Remember Password checkbox and the log in. 



Fast DBTools User Guide Starting and Connecting to the Server 

TaiRox Fast DBTools for Sage 300  3 

© 2009-2025 TaiRox Software Inc. All rights reserved.  

Using Fast DBTools 

When you connect to a SQL Server instance, Fast DBTools displays all databases on the server that your 
SQL Server user ID has permission to view. 

For example, if there are ten Sage 300 databases on the SQL Server, but your SQL login has permission 
to view only three of the databases, you will see only three databases when you log in to Fast DBTools.  

Database list 

 

• Non-Sage 300 databases appear with a red icon (!).  

A Sage 300 Database has the following attributes: 

 • Contains a Sage 300 DATADICT table. 

 • Contains table CSCOM or CSSEC. 

  ○ If the database contains a CSCOM table, it is a Sage 300 Company database 
   and it must contain only 1 company record.  
  ○ If the database does not contain a CSCOM table, but contains a CSSEC 
   table, it is a Sage 300 System Database. 

If the database does not meet these criteria, it is not a Sage 300 database. 

• Sage 300 system and company databases show a "gear" icon ( ) if a Database Setup entry is 
present. 

• Company databases display the company name.  

The above screen shows one system database and two company databases. 

• Connections to multiple SQL Server instances will show the trees stacked vertically. 
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Server operations 

Right-click on a SQL Server instance name to display operations that can be performed on that 

instance or on the selected group of Sage databases on the server. 

 

Properties – server instance details and database summary information 

Select the Properties operation to display details about the SQL Server instance and summary 

information about each database in the instance. 

 

• Click on a column heading to sort by that column. Sorting by one of the Size or Space columns 
can be useful when managing disk space. 

• Databases in Red are non-Sage databases. 

o The PORTAL DB is a non-Sage database, shown by the ! icon in the left panel. The program 

displays the database properties in the right panel. 
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Disconnect and connect to SQL Server instances 

 

To Disconnect:   

• Right-click the SQL Server instance name, and choose Disconnect. 

To Connect to a new SQL Server instance:   

• Right-click the SQL Server instance name, and choose Connect. 

OR 

• Choose File > Connect to SQL Server… from the Fast DBTools menu.  

 

The SQL Server login window will appear, where you can enter the SQL instance name and login 

user ID and password. 

Create a new Sage 300 database – use the databases pop-up menu 

Note:  Although you can right-click the Server name and choose New Database from the Server 

menu to create a Sage DB, we recommend that you create a new database by right-clicking an 
existing Sage database to use it as a model for the new one. 

See Creating New Databases, under Database Operations. 

Dump more than one Sage 300 database in a single operation 

Fast DBTools lets you dump any number of Sage 300 databases on the same server instance in a 

single, unattended operation. 

Dumps are performed using multiple threads, speeding up the overall operation. 

• Use the checkboxes to select the databases that you want to dump. 

• Right-click the SQL Server instance name, and choose Dump Databases…. 

The Dump Databases form will appear for all selected databases. 
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For details, see Dumping Databases in the next section, Database Operations. 

Database operations 

Right-click on a database name to display operations that can be performed on that database: 

 

Database properties 

Select Properties to display details about the database. The Properties panel also provides three 
functions that let you manage databases, re-index files, and free up space on the server: 
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Re-Index … 

The Re-Index… lets you rebuild corrupt and fragmented file indexes to improve database 
performance. 

Click the Re-Index button to proceed. The program will immediately scan all indexes in the 
selected database. If no indexes are recommended for re-indexing, the program will display the 
following message: 

 

Click OK to Acknowledge the message. 

To view fragmentation details for all indexes, select All from the dropdown at the top of the 
screen: 
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You can sort index files by name, size, fagmentation percent, and by recommendation for re-indexing. 

 

Select indexes that you want to re-index, and click the Re-Index button at the bottom of the screen. 

Shrink DB 

The Shrink DB button reduces the size of the database file after first displaying a warning message. 

 

Shrink Log 

The Shrink Log button reduces the size of the Log file after first displaying a warning message. 

 

Exploring datasets and displaying REC and CSV files 

Fast DBTools provides a tool for exploring datasets and displaying the contents of REC and CSV 

files. (Datasets are the files created by DBDump, and contain all the data from the Sage database.) 

 

The Dataset Explorer provides a way to browse to a directory where datasets are stored and see 
directory details in a convenient way: 
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Note that if the database has been dumped using Fast DBTools, the Collation column will display the 

database collation when the database was dumped. Databases dumped with the standard Sage 300 
utility will have a blank Collation column. 

Viewing Dataset files and records 

Double-click a dataset name to pop up a window showing all active modules in the dataset. The 

structure is shown, including keys. 

 

• Select an individual table name and click the Open button to see the rows that are in the dataset.  

• Click a column to sort by that column.  

Displaying REC files without loading the entire database into SQL Server can save minutes or 
hours for large databases. 
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Viewing and updating Sage 300 Database Setup information 

Fast DBTools lets you view Sage 300 Database Setup information and update the data source / 

server name, SQL login ID, and password settings for company databases to match new system 
database settings. This makes it easier to transfer a set of company databases to a new server. 

To view database setup information: 

• Select Tools > Sage 300 Database Setup… from the Fast DBTools menu. 

 

• Select the system database in the top grid to view all associated company databases in the 
bottom grid. 

 

To update company database profiles to match their system database (for example, after moving 
system and company databases to a new server): 

• Update the system database using Sage 300 Database Setup. 

• Log on to the server using Fast DBTools. 

• Select Tools > Sage 300 Database Setup… from the Fast DBTools menu. 

• Select the System Database in the top grid, select the Company Databases that you want to 
update in the bottom grid, and click Update Company Database Profiles. 

 

• Confirm the update by checking the box in the form that appears, and clicking the Yes button. 

 



Fast DBTools User Guide Database operations 

TaiRox Fast DBTools for Sage 300  11 

© 2009-2025 TaiRox Software Inc. All rights reserved.  

Dumping databases 

To dump any number of Sage 300 databases on the same server instance in a single, unattended 

operation:  

• Use the checkboxes to select the databases that you want to dump. 

• Right-click the SQL Server instance name, and choose Dump Databases…. 

The Dump Databases form will appear for all selected databases. 

You can also right-click on an individual database, and choose Dump 

 

 

• You can then Browse to a folder where you want to dump the new datasets, and select whether 
the dump is to a REC or CSV format. The CSV format is described in Appendix A of this 
document. 

The program automatically displays the default dataset location. You can change it. 

If you are dumping a single database (right-clicked a Database entry and chose “Dump”), the 

following screen will appear instead, allowing you to browse to a dataset folder and choose the 
format. 

 

• The program will display a warning before the dump proceeds. 

NOTE:   For single database dumps, if SQL Server objects not saved in a DBDump are present 
an additional warning will appear. Note that table-related objects will be lost during a DBLoad 
operation. 
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• Click the Copy button above the grid or click the Copy To Clipboard button at the bottom to copy 
the grid information to the Windows clipboard. 

You can then paste the information to document additional database items. 

Database: SAMLTD 

======================================== 
Object Type: Stored Procedure 
Object Name: getCurrency 
Table Name:  
Notes: Added. 

Progress window 

The progress window shows the operations being performed.  

As you can see from this screen, multiple databases are being dumped at the same time, which 

significantly speeds up the operation. 

 

The number of databases dumped at the same time is controlled by an option (Tools, Options). An 
optimal number will depend on computer and network characteristics, particularly number of CPU 
cores and disk drive characteristics: 

 

Creating new databases 

This menu choice creates a new database without opening SQL Server Management Studio, letting 
you use the settings of an existing Sage 300 database which is known to operate correctly. 

This avoids the possibility of forgetting to override certain instance defaults that are important to Sage 
300. It also eliminates the need to run Database Setup – the password for the new database is set to 
be the same as the model database.  

Select the New Database operation by right-clicking on a database name to be used as a model. In 

this example, SAMINC is used as a model for a new database TESTER: 
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When a first database is created this way in an instance - or - when there is a reason to change the 

Collation and Recovery Model settings, these settings can be changed from the drop-downs. 

• Type the name for the new database. For simplicity, you should make the DB name the same as 
the Sage Database ID. 

• Select database settings: 

o For collation, select Latin1_General_BIN (the default) unless you have a good reason to 
select a different collation. 

o Select Full Recovery Model (recommended by Sage). 

• Enter the SQL Server login ID for the new database.  The login ID must already exist for the SQL 
Server instance. 

Note that you cannot enter the Database ID or category unless you use an existing DB as a model. 

Deleting databases 

You can also delete a database with Fast DBTools.  

WARNING:  Take an offline backup before deleting databases. The program will display a 
warning notice, and as an additional protection mechanism, you will have to confirm by clicking 
on the checkbox as shown below. 

 

Loading new databases 

Loading multiple databases concurrently is not currently implemented.  

To load databases: 

• Right-click the database name to load a dataset for that database. 

• An option is provided that will set the common services company name to the description in the 
database setup tables - saving time when repeatedly loading a test copy of a database. 
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A warning message will appear before the operation starts: 

 

Fast DBLoad will operate in a fraction of the time taken by the Administrative Services ("AS") 
program. In a production-like network environment, a load time of 90 minutes was reduced to 22 
minutes on a 10.8 GB database with 384 tables. 

Fast DBTools will load a REC file or a CSV file produced by a Fast DBDump operation. If the CSV file 

is edited, the formating rules specified in Appendix A must be strictly followed. 

Loading large databases with limited disk space 

Fast DBLoad gets its performance boost by committing many table rows at a time. Until rows are 
committed, they reside in a transaction log, using up disk space.  

It is possible to cause a disk-full condition when loading a very large table onto a disk with a limited 
amount of free space. The Transaction Size setting on the Options form limits the amount of disk 
space used for large tables.  

See the explanation on the Options form for more details: 

 

 

Copying databases 

Copying multiple databases at the same time is not currently implemented.  

To copy databases: 

• Right-click the database name that you want to copy. 

Select the Copy Database operation by right-clicking on a database name: 
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• Select the Target Database.  

• Click the Yes button to continue when the warning message appears: 

 

Fast DBCopy will perform the same operation as AS DBCopy, reducing the time taken by about 40%. 

Copying a database to another SQL Server instance 

Note that when the target database is not on the same server as the source database, you must clear 

the checkbox and enter the target SQL Server instance. You must also enter the SQL Login ID and 
password for the operation.  

 

Copying across SQL Server instances takes about the same time as a DBDump and DBLoad 

operation: 

Deactivating an application (module) 

Select the Deactivate Application operation by right-clicking on a database name. You must select the 

two-character Application ID to be deactivated: 

 

A warning message will appear before the operation starts: 
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A message appears when the operation is complete: 
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Appendix A – DBDump CSV File Formats 

Formatting rules: 

• The record separator is a linefeed (or carriage return / linefeed pair). 
This means one record per line. 

• The field separator is a comma. 
Blanks before and after the separator are significant - they will not be discarded. 

• Each record must specify all fields. 

• Text fields containing record or field separators must be enclosed in quotes. 

• If a quoted text field contains a quote, then it must be escaped (i.e., doubled up) 

• The first row is a header row. It specifies the field (column) names. 

 

Example: 

CURID,AUDTDATE,AUDTTIME,AUDTUSER,AUDTORG,CURNAME,SYMBOL,DECIMALS,SYMBOLPOS,THOUSSEP,DE

CSEP,NEGDISP 

ATS,0,0, , ,Austrian Schilling,AtS,2,1,",",.,3 

AUD,0,0, , ,Australian Dollars,$,2,1,",",.,3 

BEF,0,0, , ,Belgian Franc,BeF,2,1,",",.,3 

CAD,0,0, , ,Canadian Dollars,$,2,1,",",.,3 

CHF,0,0, , ,Swiss Francs,SwF,2,1,",",.,3 

CNY,0,0, , ,People's Rep of China Renminbi,RMB,2,1,",",.,3 

DEM,0,0, , ,Deutsche Mark,DM,2,3,",",.,1 

ESP,0,0, , ,Spanish Peseta,Pta,2,1,",",.,3 

EUR,0,0, , ,Euro,€,2,1,",",.,3 

FIM,0,0, , ,Finnish Markka,FiM,2,1,",",.,3 

FJD,0,0, , ,Fijian Dollars,$,2,2,",",.,3 

FRF,0,0, , ,French Francs,F,2,1,",",.,3 

GBP,0,0, , ,Pound Sterling,£,2,1,",",.,3 

GRD,0,0, , ,Greek Drachma,DR,2,1,",",.,3 

HKD,0,0, , ,Hong Kong Dollars,$,2,1,",",.,3 

IDR,0,0, , ,Indonesian Rupiah,Rp.,0,1,.,",",3 

IEP,0,0, , ,Irish Punt,Ir£,2,1,",",.,3 

ITL,0,0, , ,Italian Lira,L.,0,1,.,",",3 

JPN,0,0, , ,Japanese Yen,¥,0,1,",",.,3 

JPY,0,0, , ,Japanese Yen,¥,0,1,",",.,3 

KIP,0,0, , ,Laos Kip,KIP,2,3,",",.,3 

LUF,0,0, , ,Luxembourg Franc,LuF,2,1,",",.,3 

MXP,0,0, , ,Mexican Pesos,$,0,1,",",.,3 

MYR,0,0, , ,Malaysian Ringgit,RM,2,1,",",.,3 

NLG,0,0, , ,Netherland Guilders,f.,2,1,",",.,3 

NTD,0,0, , ,New Taiwan Dollar,NT$,0,1,",",.,2 

NZD,0,0, , ,New Zealand Dollars,$,2,2,",",.,3 

PGK,0,0, , ,Papua New Guinea Kina,K,2,2,",",.,3 

PTE,0,0, , ,Portuguese Escudo,Esc.,2,1,",",.,3 

SGD,0,0, , ,Singapore Dollars,S$,2,2,",",.,3 

SLR,0,0, , ,Sri Lankan Rupees,Rs.,2,1,",",.,3 

THB,0,0, , ,Thai Baht,ß,2,3,",",.,3 

USD,0,0, , ,U.S. Dollars,$,2,1,",",.,3 

VND,0,0, , ,Viet Nam Dong,VND,0,1,",",.,3 

ZAR,0,0, , ,South African Rand,R,2,2, ,.,3 
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Appendix B – Setting Up SQL User Access 
for Fast DBTools 

This appendix provides steps for adding a new SQL user and providing user access to one or more 
databases for Fast DBTools.  

1. Use SQL Server Management Studio to create a new SQL Login for the user. If different users 
have access to different companies, you will need a minimum of one SQL login per combination 
of companies. 

o Choose SQL Server authentication. 

 

2. On the Login Properties form - Server Roles page, select “public” as the role. 

 

3. On the Login Properties form - User Mapping page, select the “db_owner” role for EACH database 
you want the user to be able to access. 

o Select the database in the top grid, then select db_owner as the role in the bottom grid. 
o Specify “dbo” as the default schema. 
o Select the next DB, etc. 
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When you log in to SQL Server as the new user for Fast DBTools, you will have access to the databases 

that you specified. 

When you log in Fast DBTools as the new SQL user, you will see the databases that you specified in 

SQL Server Management Studio. 
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Appendix C – Activating Logging 

Fast DBTools lets you record all program activity in a log file.  

To activate logging: 

• Open Logger.ini in "C:\ProgramData\TaiRox Software Inc\TaiRox Fast DBTools". 

 

• Change the LOGGING LEVEL setting to “ALL”, and save the configuration file.  

 

The Fast DBTools log file will appear in the user’s Documents folder – shown below: 
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Appendix D – Using Fast DBTools with 
Azure SQL Databases 

Note the following restrictions / limitations if you are using Fast DBTools on an Azure SQL Database 

We created system and company databases in an Azure test environment and found the following 
limitations. 

• You cannot create or delete databases. These functions are not disabled, but an error is 
displayed indicating that you must use the Microsoft Azure portal to create and delete databases. 

• You can only work with databases that you created (i.e., for which you are the owner) or 
databases for which you are a member of the db_owner role.  

• You cannot get exclusive access when dumping, loading, or copying databases. The option is 
deselected and disabled. 

• Not all information on the server and database properties screens is available.  
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Fast DBTools FAQ 

Read the user guide carefully in addition to reviewing this FAQ. The user guide provides 
specific guidelines for using Fast DBTools. 

Installation and Upgrade Issues 

Q: What versions of Sage 300 does Fast DBTools support? 

A Platform Requirements 

• Sage ERP Accpac version 5.6 or 6.0 or Sage 300 2012 to 2025 

• A single executable program works with all platforms 

• Microsoft SQL Server is required 

• .NET Framework 4.6.2 or higher is required 

Q: Where can I get release notes for Fast DBTools, and what will they tell me? 

A: Click the Release Notes link in the upper left-hand corner of the FastDB Tools product page 
on the TaiRox web site. 

Among other things, the Release Notes will tell you about recent fixes and provide program 
compatibility information. For example: 
 

Build 2020-06-25 

Build 2020-06-05 

 - Improvements to licensing diagnostics. 

 

Build 2020-05-12 

 - Support added for Azure SQL Server. 

 

Build 2019-08-15 

 - Resolves display problems with low screen resolution computers. 

 - Support for Sage 300 2020. 

DBDump and DBLoad 

Q: What’s the purpose of the DBDump and DBLoad utilities? 

A: DBDump and DBLoad are Sage utilities for exporting Sage 300 data to flat files – for backup 
or data transfer – then loading them into a SQL database. 

 See the following entry from Stephen Smith’s blog for more information on DBDump and 
DBLoad files: https://smist08.wordpress.com/2010/08/07/on-database-dump-and-load/. 
(Stephen Smith was manager and chief architect for Sage 300 from 1992 to 2016.) 

http://tairox.com/downloads/fastdbtools/FastDBToolsReleaseNotes.txt
https://smist08.wordpress.com/2010/08/07/on-database-dump-and-load/
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Q: Why do I get fewer .REC files with Fast DBTools that when I use Sage’s 
DBDump utility? 

A: Sage's DBDump utility will produce a 0-byte .REC file for a table with no records, whereas 
Fast DBTools will skip the .REC file altogether. Check whether the missing REC files are 0-
byte files.  

Q: I received a “Database Schema Changes” message saying that “objects would 
not be saved” when trying to dump a client database using Fast DB Tools – 
what does it mean? 

  

A: The message is displayed when a database has triggers, extra columns, additional indexes, 
stored procedures, etc. that were not added by software using Sage's interface (database 
API).  

It is a warning that if you restore from the DBDump files, those changes to the database that 
Sage knows nothing about will be lost. You need to see what they are, understand why they 
are there, and how to move them across to a new database when you restore. 

 Note:  You will see “Index count different” messages (shown in the above screen shot) if 
you use Sage’s Global Search. Global Search added indexes are all the same – the audit 
stamp – so that when the GS database is refreshed every 10 minutes, GS can quickly find 
the rows that have changed. After a DBLoad, Global Search will "refresh" (i.e., rebuild) the 
indexes. 

“Index count different” messages can also appear if someone adds indexes to improve the 
performance of Sage reports. These indexes will not be automatically rebuilt. 

Deactivating Applications 

Q: What does deactivation do and why would I deactivate an application? 

A: The purpose of deactivation is to remove old programs that are no longer used from the 
Sage 300 environment. 

Always test the effects of deactivating an application on a copy of your database first. 
Run data integrity before and after deactivation to check if it caused any damage. 
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 Deactivation has the following effects: 

• It removes the application from CSAPP – the module no longer appears on the Sage 
desktop 

• It drops all database tables for the deactivated module 

• It does not touch data in other modules – so destination tables in G/L and BK will retain 
data. You may see errors if you attempt to drill down to missing data – or drilldown 
buttons may be hidden. 

Q: Is deactivation safe to do? 

A: It deletes all tables for the module. It is safe to do if you do not need or want the data. 

SQL Server Issues 

Q: Why did I get the message “Could Not Allocate Space for Object”? 

A: Google "Could not allocate space for object" and you'll see various support sites that take 
you through what to do. The basic issue involves lack of space in the primary file group, not 
disk space. You will see results are like these: 

https://support.managed.com/kb/a132/error-could-not-allocate-space-object-x-database-your-

database-because-primary-filegroup-is-full.aspx 

https://www.google.com/url?sa=t&rct=j&q=&esrc=s&source=web&cd=4&cad=rja&uact=8&ved=2ahU

KEwii2Zj5o7bdAhVhj1QKHSHjBEUQFjADegQIBxAB&url=https%3A%2F%2Fstackoverflow.com%2Fq
uestions%2F19114680%2Fcould-not-allocate-space-for-object-dbo-
table&usg=AOvVaw3C_Zq0goKVhNNZ1Q2Zt370 

Q: What permissions are needed for Fast DB Tools to function on select 
databases? 

We want to set up a SQL user account that will only show allowed databases. We 
cannot give end users “SA” account access or access to restricted databases. 

A: The permissions required vary depending on the tasks you are asking Fast DBTools to 
perform. Note that the “restricted” users cannot create or delete companies. 

You can probably achieve what you want by following these steps: 

1. Create the SQL Login for the user. If different users have access to different companies, you will 
need a minimum of one SQL login per combination of companies. 

2. On the Login Properties form - Server Roles page, select 'public' as the role. 

 

3. On the Login Properties form - User Mapping page, select the 'db_owner' role for EACH database 
you want the user to be able to access. 

https://support.managed.com/kb/a132/error-could-not-allocate-space-object-x-database-your-database-because-primary-filegroup-is-full.aspx
https://support.managed.com/kb/a132/error-could-not-allocate-space-object-x-database-your-database-because-primary-filegroup-is-full.aspx
https://www.google.com/url?sa=t&rct=j&q=&esrc=s&source=web&cd=4&cad=rja&uact=8&ved=2ahUKEwii2Zj5o7bdAhVhj1QKHSHjBEUQFjADegQIBxAB&url=https%3A%2F%2Fstackoverflow.com%2Fquestions%2F19114680%2Fcould-not-allocate-space-for-object-dbo-table&usg=AOvVaw3C_Zq0goKVhNNZ1Q2Zt370
https://www.google.com/url?sa=t&rct=j&q=&esrc=s&source=web&cd=4&cad=rja&uact=8&ved=2ahUKEwii2Zj5o7bdAhVhj1QKHSHjBEUQFjADegQIBxAB&url=https%3A%2F%2Fstackoverflow.com%2Fquestions%2F19114680%2Fcould-not-allocate-space-for-object-dbo-table&usg=AOvVaw3C_Zq0goKVhNNZ1Q2Zt370
https://www.google.com/url?sa=t&rct=j&q=&esrc=s&source=web&cd=4&cad=rja&uact=8&ved=2ahUKEwii2Zj5o7bdAhVhj1QKHSHjBEUQFjADegQIBxAB&url=https%3A%2F%2Fstackoverflow.com%2Fquestions%2F19114680%2Fcould-not-allocate-space-for-object-dbo-table&usg=AOvVaw3C_Zq0goKVhNNZ1Q2Zt370
https://www.google.com/url?sa=t&rct=j&q=&esrc=s&source=web&cd=4&cad=rja&uact=8&ved=2ahUKEwii2Zj5o7bdAhVhj1QKHSHjBEUQFjADegQIBxAB&url=https%3A%2F%2Fstackoverflow.com%2Fquestions%2F19114680%2Fcould-not-allocate-space-for-object-dbo-table&usg=AOvVaw3C_Zq0goKVhNNZ1Q2Zt370
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When you log in to Fast DBTools as the new test user, you should see only the two databases 

that you selected above, and you should be able to dump and load them, as well as shrink the 
database and log files. 

 

Q: How do I activate logging? 

A: Fast DBTools lets you record all program activity in a log file. To activate logging: 

• Open the Fast DBTools program directory, and edit DBToolsMT.exe.config. 

• Change the LOGGING LEVEL setting to “ALL”, and save the configuration file.  

        <setting name="LOGGING_LEVEL" serializeAs="String"> 

            <value>ALL</value> 

The log file appears in the user’s Documents folder. Each time you run Fast DBTools, the 
program will append to the existing log file. 
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